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Multifactor RSM Tutorial  

(Part 1 ς The Basics) 

Response Surface Design and Analysis 

This tutorial shows how to use Design-Expert® software for response surface 
methodology (RSM).  This class of designs is aimed at process optimization.  A case 
study provides a real-life feel to the exercise. 

Due to the specific nature of this case study, a number of features that could be 
helpful to you for RSM will not be implemented in this tutorial.  Many of these 
features are used in the General One Factor, RSM One Factor, or Two-Level 
Factorial tutorials.  If you have not completed all these tutorials, consider doing so 
before starting this one. 

We will presume that you are knowledgeable of the statistical aspects of RSM.  For 
a good primer on the subject, see RSM Simplified (Anderson and Whitcomb, 
Productivity, Inc., New York, 2005).  You will find overviews on RSM and how itȭs 
done via Design-Expert in the on-line Help system.  To gain a working knowledge of 
RSM, we recommend you attend our Response Surface Methods for Process 
Optimization workshop.  Call Stat-Ease or visit our website for a schedule at 
www.statease.com,. 

The case study in this tutorial involves production of a chemical.  The two most 
ÉÍÐÏÒÔÁÎÔ ÒÅÓÐÏÎÓÅÓȟ ÄÅÓÉÇÎÁÔÅÄ ÂÙ ÔÈÅ ÌÅÔÔÅÒ Ȱyȱȟ ÁÒÅȡ 

¶ y1 - Conversion (% of reactants converted to product) 

¶ y2 - Activity. 

The experimenter chose three process factors to study.  Their names and levels are 
shown in the following table. 

Factor Units Low Level (-1) High Level (+1) 

A ɀ Time minutes 40 50 

B ɀ Temperature degrees C 80 90 

C ɀ Catalyst percent 2 3 

Factors for response surface study 

You will study the chemical process using a standard RSM design called a central 
composite design (CCD).  )ÔȭÓ ×ÅÌÌ ÓÕÉÔÅÄ ÆÏÒ ÆÉÔÔÉÎÇ Á ÑÕÁÄÒÁÔÉÃ ÓÕÒÆÁÃÅȟ ×ÈÉÃÈ 
usually works well for process optimization.  The three-factor layout for this CCD is 
pictured below.  It is composed of a core factorial that forms a cube with sides that 
are two coded units in length (from -1 to +1 as noted in the table above).  The stars 
represent axial points.  How far out from the cube these should go is a matter for 
much discussion between statisticians.  4ÈÅÙ ÄÅÓÉÇÎÁÔÅ ÔÈÉÓ ÄÉÓÔÁÎÃÅ ȰÁÌÐÈÁȱ ɀ 
measured in terms of coded factor levels.  As you will see, Design-Expert offers a 
variety of options for alpha. 

http://www.statease.com/
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Central Composite Design for three factors 

Assume that the experiments will be conducted over a two-day period, in two 
blocks: 

1. Twelve runs: composed of eight factorial points, plus four center points. 

2. Eight runs: composed of six axial (star) points, plus two more center 
points. 

Design the Experiment 

Start the program by finding and double clicking the Design-Expert software icon.  
Take the quickest route to initiating a new design by clicking New Design near the 
center of the opening screen, as shown below.  Two other routes are available:  
Click the blank-sheet icon / on the left of the toolbar, or choose File, New Design 
(or associated Alt keys) from the main menu atop your screen. 

 
Design-Expert opening screen 

Click the Response Surface folder tab to show the designs available for RSM. 

 
Response surface design tab 
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The default selection is the Central Composite design, which is used in this case 
study.  Click the down arrow in the Numeric Factors entry box and Select 3 as 
shown below.   

 
Selecting 3 numeric factors 

To see alternative RSM designs for three factors, click at far left on Box-Behnken 
(notice 17 runs near the screen bottom) and Miscellaneous designs, where you 
find the 3-Level Factorial option (32 runs, including 5 center points).  Now go back 
and re-select Central Composite design. 

Before entering factors and ranges, click Options near the bottom of the CCD 
screen.  Notice that it defaults to a Rotatable design with the axial (star) points set 
at 1.68179 coded units from the center ɀ a conventional choice for the CCD. 

 
Default CCD option for alpha set so design is rotatable 

Many options are statistical in nature, but one that produces less extreme factor 
ranges ÉÓ ÔÈÅ Ȱ0ÒÁÃÔÉÃÁÌȱ ÖÁÌÕÅ ÆÏÒ ÁÌÐÈÁ.  This is computed by taking the fourth root 
of the number of factors (in this case 3¼ or 1.31607).  See RSM Simplified Chapter 8 
Ȱ%ÖÅÒÙÔÈÉÎÇ 9ÏÕ 3ÈÏÕÌÄ +ÎÏ× !ÂÏÕÔ ##$Ó ɉÂÕÔ ÄÁÒÅ ÎÏÔ ÁÓËȦɊȱ for details on this 
practical versus other levels suggested for alpha in CCDs ɀ the most popular of 
×ÈÉÃÈ ÍÁÙ ÂÅ ÔÈÅ Ȱ&ÁÃÅ #ÅÎÔÅÒÅÄȱ ɉÁÌÐÈÁ ÅÑÕÁÌs one).  Press OK to accept the 
rotatable value. 

Using the information provided in the table on page 1 of this tutorial (or on the 
screen capture below), type in the details for factor Name (A, B, C), Units, and Low 
and High levels. 
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Completed factor form 

9ÏÕȭÖÅ ÎÏ× ÓÐÅÃÉÆÉÅÄ ÔÈÅ ÃÕÂÉÃÁÌ ÐÏÒÔÉÏÎ ÏÆ ÔÈÅ ##$Ȣ  As you did this,  
Design-Expert calculated ÔÈÅ ÃÏÄÅÄ ÄÉÓÔÁÎÃÅ ȰÁÌÐÈÁȱ ÆÏÒ ÐÌÁÃÅÍÅÎÔ ÏÎ ÔÈÅ ÓÔÁÒ 
points in the central composite design.  Alternati vely, by clicking ÔÈÅ Ȱentered 
ÆÁÃÔÏÒ ÒÁÎÇÅÓ ÉÎ ÔÅÒÍÓ ÏÆ ÁÌÐÈÁÓȱ ÏÐÔÉÏÎ ÙÏÕ ÃÁÎ ÃÏÎÔÒÏÌ ÈÏ× ÆÁÒ ÏÕÔ ÔÈÅ ÒÕÎÓ ×ÉÌÌ ÇÏ 
for each of your factors. 

Now return  to the bottom of the central composite design form.  Leave Type at its 
default value of Full (the other ÏÐÔÉÏÎ ÉÓ Á ȰÓÍÁÌÌȱ ##$ȟ ×ÈÉÃÈ ×Å ÄÏ ÎÏÔ 
recommend unless you must reduce the number of runs to the bare minimum).  
You will need two blocks for this design, one for each day, so click the Blocks field 
and select 2. 

 
Selecting the number of blocks 

Notice the software displays how this CCD will be laid out in the two blocks ɀ for 
example, 4 center points will go in one and 2 in the other.  Click Continue to reach 
ÔÈÅ ÓÅÃÏÎÄ ÐÁÇÅ ÏÆ ÔÈÅ Ȱ×ÉÚÁÒÄȱ ÆÏÒ ÂÕÉÌÄÉÎÇ Á ÒÅÓÐÏÎÓÅ ÓÕÒÆÁÃÅ ÄÅÓÉÇÎȢ  You now 
have the option of identifying Block Names.  Enter Day 1 and Day 2 as shown 
below. 

 
Block names 

Press Continue to enter Responses.  Select 2 from the pull down list.  Now enter 
the response Name and Units for each response as shown below. 
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Completed response form 

At any time in the design-building phase, you can return to the previous page by 
pressing the Back button.  Then you can revise your selections.  Press Continue to 
view the design layout (your run order may differ due to randomization). 

Design-%ØÐÅÒÔ ÏÆÆÅÒÓ ÍÁÎÙ ×ÁÙÓ ÔÏ ÍÏÄÉÆÙ ÔÈÅ ÄÅÓÉÇÎ ÁÎÄ ÈÏ× ÉÔȭÓ ÌÁÉÄ ÏÕÔ ÏÎ-
screen.  Preceding tutorials, especially Part 2 for General One Factor, delved into 
ÔÈÉÓ ÉÎ ÄÅÔÁÉÌȟ ÓÏ ÇÏ ÂÁÃË ÁÎÄ ÌÏÏË ÔÈÉÓ ÏÖÅÒ ÉÆ ÙÏÕ ÈÁÖÅÎȭÔ ÁÌÒÅÁÄÙȢ  #ÌÉÃË ÔÈÅ 4ÉÐÓ 
button for a refresher. 

 
Design layout (only partially shown, your run order may differ due to randomization) 

Save the Data to a File 

.Ï× ÔÈÁÔ ÙÏÕȭÖÅ ÉÎÖÅÓÔÅÄ ÓÏÍÅ ÔÉÍÅ ÉÎÔÏ ÙÏÕÒ ÄÅÓÉÇÎȟ ÉÔ ×ÏÕÌÄ ÂÅ ÐÒÕÄÅÎÔ ÔÏ ÓÁÖÅ 
your work.  Click the File menu item and select Save As. 
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Save As selection 

You can now specify your File name (we suggest tut-RSM) to Save as type Ȱ*.dxpȱ 
in the Data folder for Design-Expert (or wherever you want to Save in). 

 
File Save As dialog box 

Enter the Response Data ς Create Simple Scatter Plots 

Assume that the experiment is now completed.  Obviously at this stage the 
responses must be entered into Design-Expert.  We see no benefit to making you 
type all the numbers, particularly with the potential confusion due to differences in 
randomized run orders.  Therefore, use the File, Open Design menu and select 
RSM.dxp from the Design-Expert program Data directory.  Click Open to load the 
data. 

,ÅÔȭÓ ÅØÁÍÉÎÅ ÔÈÅ ÄÁÔÁ, which came in with the file you opened (no need to type it 
in!).  Move your cursor to the top of the Std column and right -click to bring up a 
menu from which to select Sort by Standard Order (this could also be done via 
the View menu). 

 
Sorting by Standard (Std) Order 

Now right -mouse click the Select column header and choose Point Type. 



DX8-04C-MultifactorRSM-P1.docx Rev. 4/8/10 

Design-9ȄǇŜǊǘ у ¦ǎŜǊΩǎ DǳƛŘŜ                                Multifactor RSM Tutorial ς Part 1 ¶ 7 

 
Displaying the Point Type 

Notice the new column identifying  points as Ȱ&ÁÃÔorial,ȱ Ȱ#ÅÎÔÅÒȱ (for center point), 
and so on.  Notice how the factorial points align only to the Day 1 block.  Then in 
Day 2 the axial points are run.  Center points are divided between the two blocks. 

Unless you change the default setting for the Select option, do not expect the Type 
column to appear the next time you run Design-Expert.  It is only on temporarily at 
this stage for your information. 

Before analyzing this, it might be interesting to look at some simple plots.  Click the 
Graph Columns node branching ÆÒÏÍ ÔÈÅ ÄÅÓÉÇÎ ȬÒÏÏÔȭ ÁÔ ÔÈÅ ÕÐÐÅÒ ÌÅÆÔ ÏÆ ÙÏÕÒ 
screen.  You should see a scatter plot with factor A:Time on the X-axis and the 
Conversion response on the Y-axis.  For now it is most useful to produce a plot 
showing the impact of blocks because this will be literally blocked out in the 
analysis.  Therefore, on the floating Graph Columns tool click the X Axis droplist 
arrow and select Block. 
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Graph Columns feature for design layout 

The graph shows a slight correlation (0.152) of conversion by block.  Change the Y 
Axis to Activity to see how itȭs affected by the day-to-day blocking (not much!).  

 
Changing response (resulting graph not shown) 

Finally, to see how the responses correlate with each other, change the X Axis to 
Conversion. 

 
Plotting one response versus the other (resulting graph not shown) 

Feel free to make other scatter plots.  Notice you can also color selected factors, 
including run (default).  For example, choose Color by Block to see which points 
were run in block 1 (black) and block 2 (red).   
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Graph columns with points colored by Block 

However, do not get carried away with this, because it will be much more 
productive to do statistical analysis first ɀ before drawing any conclusions. 

Analyze the Results 

.Ï× ÌÅÔȭÓ start analyzing the responses numerically.  Under the Analysis branch 
click the node labeled Conversion.  A new set of buttons appears at the top of your 
screen.  They are arranged from left to right in the order needed to complete the 
analysis.  What could be simpler? 

 
Begin analysis of Conversion 

Design-Expert provides a full array of response transformations via the Transform 
option.  Click Tips for details.  For now, accept the default transformation selection 
of None. 
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Now click the Fit Summary button.  At this point Design-Expert fits linear, two-
factor interaction (2FI), quadratic, and cubic polynomials to the response.  At the 
top is the response identification, immediately followed below, in this case, by a 
×ÁÒÎÉÎÇȡ Ȱ4ÈÅ #ÕÂÉÃ -ÏÄÅÌ and higher are AliasedȢȱ  Do not be alarmed.  By design, 
the central composite matrix provides too few unique design points to determine 
all thÅ ÔÅÒÍÓ ÉÎ ÔÈÅ ÃÕÂÉÃ ÍÏÄÅÌȢ  )ÔȭÓ set up only for the quadratic model (or some 
subset).  Next you will see several extremely useful tables for model selection. (To 
move through the display, use the floating Bookmarks palette or the side/ bottom 
scroll bars).  Each table is discussed briefly below. 

The table of Ȱ3ÅÑÕÅÎÔÉÁÌ -ÏÄÅÌ 3ÕÍ ÏÆ 3ÑÕÁÒÅÓȱ ɉÔÅÃÈÎÉÃÁÌÌÙ Ȱ4ÙÐÅ IȱɊ shows how 
terms of increasing complexity contribute to the total model.  The model hierarchy 
is described below: 

¶ Ȱ,ÉÎÅÁÒ vs Blockȱȡ ÔÈÅ ÓÉÇÎÉÆÉÃÁÎÃÅ ÏÆ ÁÄÄÉÎÇ ÔÈÅ ÌÉÎÅÁÒ ÔÅÒÍÓ ÔÏ Ôhe 
mean and blocks, 

¶ Ȱς&) vs Linearȱȡ ÔÈÅ ÓÉÇÎÉÆÉÃÁÎÃÅ ÏÆ ÁÄÄÉÎÇ ÔÈÅ Ô×Ï ÆÁÃÔÏÒ ÉÎÔÅÒÁÃÔÉÏÎ 
terms to the mean, block, and linear terms already in the model, 

¶ Ȱ1ÕÁÄÒÁÔÉÃ vs 2FIȱȡ ÔÈÅ ÓÉÇÎÉÆÉÃÁÎÃÅ ÏÆ ÁÄÄÉÎÇ ÔÈÅ ÑÕÁÄÒÁÔÉÃ ɉÓÑÕÁÒÅÄɊ 
terms to the mean, block, linear, and two-factor interaction terms 
already in the model, 

¶ Ȱ#ÕÂÉÃ vs Quadraticȱȡ ÔÈÅ ÓÉÇÎÉÆÉÃÁÎÃÅ ÏÆ ÔÈÅ ÃÕÂÉÃ ÔÅÒÍs beyond all 
other terms. 

 
Sequential Model Sum of Squares 
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For each source of terms (linear, etc.), examine the probability ɉȰ0ÒÏÂ Є &ȱɊ ÔÏ ÓÅÅ ÉÆ 
it falls below 0.05 (or whatever statistical significance level you choose).  So far, 
Design-Expert is indicating (via underline) the quadratic model looks best ɀ these 
terms are significant, but adding the cubic order terms will not significantly 
improve the fit.  (Even if they were significant, the cubic terms would be aliased, so 
they woÕÌÄÎȭÔ ÂÅ ÕÓÅÆÕÌ ÆÏÒ ÍÏÄÅÌÉÎÇ ÐÕÒÐÏÓÅÓȢɊ  Use the handy Bookmarks or 
scroll down to the next table for lack of fit tests on the various model orders. 

 
Summary Table: Lack of Fit Tests 

4ÈÅ Ȱ,ÁÃË ÏÆ &ÉÔ 4ÅÓÔÓȱ ÔÁÂÌÅ ÃÏÍÐÁÒÅÓ ÒÅÓÉÄÕÁÌ ÅÒÒÏÒ with  Ȱ0ÕÒÅ %ÒÒÏÒȱ from 
replicated design points.  If there is significant lack of fit, as shown by a low 
ÐÒÏÂÁÂÉÌÉÔÙ ÖÁÌÕÅ ɉȰ0ÒÏÂЄ&ȱɊȟ ÔÈÅÎ ÂÅ ÃÁÒÅÆÕÌ ÁÂÏÕÔ ÕÓÉÎÇ ÔÈÅ ÍÏÄÅÌ ÁÓ Á ÒÅÓÐÏÎÓÅ 
predictor.  In this case, the linear model definitely can be ruled out, because its Prob 
> F falls below 0.05.  The quadratic model, identified earlier as the likely model, 
does not show significant lack of fit.  Remember that the cubic model is aliased, so it 
should not be chosen. 

Scroll down to the last table in the Fit Summary report, which ÐÒÏÖÉÄÅÓ Ȱ-ÏÄÅÌ 
3ÕÍÍÁÒÙ 3ÔÁÔÉÓÔÉÃÓȱ ÆÏÒ ÔÈÅ ȬÂÏÔÔÏÍ ÌÉÎÅȭ ÏÎ ÃÏÍÐÁÒÉÎÇ ÔÈÅ ÏÐÔÉÏÎÓȢ 

 
Summary Table: Model Summary Statistics 

4ÈÅ ÑÕÁÄÒÁÔÉÃ ÍÏÄÅÌ ÃÏÍÅÓ ÏÕÔ ÂÅÓÔȡ )Ô ÅØÈÉÂÉÔÓ ÌÏ× ÓÔÁÎÄÁÒÄ ÄÅÖÉÁÔÉÏÎ ɉȰ3ÔÄȢ 
$ÅÖȢȱɊȟ ÈÉÇÈ Ȱ2-3ÑÕÁÒÅÄȱ ÖÁÌÕÅÓ, ÁÎÄ Á ÌÏ× Ȱ02%3SȢȱ 

4ÈÅ ÐÒÏÇÒÁÍ ÁÕÔÏÍÁÔÉÃÁÌÌÙ ÕÎÄÅÒÌÉÎÅÓ ÁÔ ÌÅÁÓÔ ÏÎÅ Ȱ3ÕÇÇÅÓÔÅÄȱ ÍÏÄÅÌȢ  !Ì×ÁÙÓ 
confirm this suggestion by viewing these tables.  Check Tips for more information 
about the procedure for choosing model(s). 
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Design-Expert allows you to select a model for in-depth statistical study. Click the 
Model button at the top of the screen to see the terms in the model. 

 
Model results 

4ÈÅ ÐÒÏÇÒÁÍ ÄÅÆÁÕÌÔÓ ÔÏ ÔÈÅ Ȱ3ÕÇÇÅÓÔÅÄȱ ÍÏÄÅÌ shown in the earlier Fit Summary 
table.  If you want, you can choose an alternative model from the Process Order 
pull -down list.  (Be sure to do this in the rare cases when Design-Expert suggests 
more than one model.) 

 
The options for process order 

At this stage you could press the Add Term button and insert higher degree terms 
with integer powers, such as quartic (4th degree).  However, for this case study, 
×ÅȭÌÌ ÌÅÁÖÅ ÔÈÅ ÓÅÌÅÃÔÉÏÎ ÁÔ Quadratic. 

Also, you could now manually reduce the model by clicking off insignificant effects.  
For example, you will see in a moment that several terms in this case are marginally 
significant at best.  Design-Expert also provides several automatic reduction 
ÁÌÇÏÒÉÔÈÍÓ ÁÓ ÁÌÔÅÒÎÁÔÉÖÅÓ ÔÏ ÔÈÅ Ȱ-ÁÎÕÁÌȱ ÍÅÔÈÏÄȡ Ȱ"ÁÃË×ÁÒÄȟȱ Ȱ&ÏÒ×ÁÒÄ,ȱ ÁÎÄ 
Ȱ3ÔÅÐ×ÉÓÅȢȱ  #ÌÉÃË ÔÈÅ Selection list box to use these. 

Click the ANOVA button to produce the analysis of variance for the selected model.  
The ANOVA table is available in two views.  By default it adds text providing brief 
explanations and guidelines to the reported statistics.  To turn this on ɉЍɊ or off, 
choose View, Annotated ANOVA. 
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Statistics for selected model: ANOVA table 

The ANOVA in this case confirms the adequacy of the quadratic model (the Model 
Prob>F is less than 0.05.)  You can also see probability values for each individual 
term in the model.  You may want to consider removing terms with probability 
values greater than 0.10.  Use process knowledge to guide your decisions. 

Next, see that Design-Expert presents various statistics to augment the ANOVA ɀ 
most notably various R-Squared values.  These are very good ɀ near to 1. 

 
Post-ANOVA statistics 

Scroll down (or use the Bookmark) to bring the following details on model 
coefficients to your screen.  The mean effect-shift for each block is listed here too. 
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Coefficients for the quadratic model 

Again scroll down to bring the next section to your screen: the predictive models in 
terms of coded versus actual factors (shown side-by-side below).  Block terms are 
left out.  These terms can be used to re-create the results of this experiment, but 
they cannot be used for modeling future responses. 

 
Final equation: coded versus actual 

You cannot edit any ANOVA outputs.  However, you can copy and paste the data to 
your favorite Windows word processor or spreadsheet. 

Diagnose the Statistical Properties of the Model 

The diagnostic details provided by Design-Expert can best be grasped by viewing 
plots available via the Diagnostics button.  The most important diagnostic ɀ 
normal probability plot of the residuals ɀ appears by default. 
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Normal probability plot of the residuals 

Data points should be approximately linear.  A non-linear pattern (such as an S-
shaped curve) indicates non-normality in the error term, which may be corrected 
by a transformation.  There are no signs of any problems in this data. 

Find the floating Diagnostics Tool palette on your screen.  First, notice that 
residuals are studentized unless you uncheck the first box on the floating tool 
palette (not advised).  Studentized residuals counteract varying leverages due to 
design point locations.  For example, center points carry little weight in the fit and 
thus exhibit low leverage.  Each button on the palette represents a different 
diagnostics graph.  Check out the other graphs if you like.  Explanations for most of 
these graphs were covered in prior  Tutorials.  In this case, none of the graphs 
indicates any cause for alarm. 

Now click the Influence option found on the Diagnostics Tool palette.  (ÅÒÅȭÓ ×ÈÅÒÅ 
you find ÐÌÏÔÓ ÆÏÒ ÅØÔÅÒÎÁÌÌÙ ÓÔÕÄÅÎÔÉÚÅÄ ÒÅÓÉÄÕÁÌÓ ɉÂÅÔÔÅÒ ËÎÏ×Î ÁÓ ȰÏÕÔÌÉÅÒ ÔȱɊ ÁÎÄ 
other plots that may be helpful for finding problem points in the design.  Also, from 
here you can click Report to bring up detailed case-by-case diagnostic statistics, 
many which have already been shown graphically.  (In previous versions of Design-
Expert, this report appeared under ANOVA.) 




